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Preface

SQL*Plus Getting Started for Windows provides information about the SQL*Plus 
product specific to  Windows XP Pro, Windows 2000, Windows NT 4.0 and 
Windows 98 operating systems. In the remainder of this guide SQL*Plus for 
Windows is referred to as SQL*Plus.

This preface contains the following topics:

■ Audience

■ Organization

■ Related Documentation

■ Conventions

■ Documentation Accessibility
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Audience
SQL*Plus Getting Started for Windows is intended for business and technical users 
and system administrators who want to use SQL*Plus in the Windows XP Pro, 
Windows 2000, Windows NT 4.0 and Windows 98 operating system environments.

This guide assumes that you are familiar with:

■ SQL*Plus commands and general features. You should refer to the generic 
SQL*Plus documentation set before using this guide. See "Related 
Documentation" later in this chapter.

■ Commands for deleting and copying files and the concepts of the search path, 
subdirectories, and path names.

■ Fundamentals of the Windows XP Pro, Windows 2000, Windows NT 4.0 and 
Windows 98 operating systems.

To use this guide, you need a basic understanding of the SQL database language. If 
you do not have any familiarity with this database tool, you should refer to the 
Oracle9i SQL Reference. If you plan to use the PL/SQL database language in 
conjunction with SQL*Plus, refer to the PL/SQL User’s Guide and Reference for 
information on using PL/SQL.

Organization
This guide contains:

Chapter 1, "Introducing SQL*Plus"
Provides introductory information to help you get started with SQL*Plus for 
Windows.

Chapter 2, "Installing SQL*Plus Help and Demonstration Tables"
Explains how to install and access SQL*Plus Help and Demonstration tables.

Chapter 3, "Using SQL*Plus"
Describes what user interfaces are available and explains how to start and use 
SQL*Plus from the command-line interface and the graphical user interface, and 
describes the graphical user interface menu options.
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Chapter 4, "Operating System-Specific References"
Provides command information specific to the Windows XP/2000/NT/98 
environments which are cross-referenced in SQL*Plus User’s Guide and Reference.

Appendix A, "Customizing Operating System Parameters"
Explains how to customize your SQL*Plus configuration by changing Windows 
registry entries and by setting the SQLPLUS environment variable.

Related Documentation
SQL*Plus Getting Started for Windows provides information specific to SQL*Plus 
on Windows-based platforms only. For information about SQL*Plus 
cross-platform support, features, and commands, and for information about 
iSQL*Plus, the new web browser-based user interface to SQL*Plus, refer to the 
generic SQL*Plus documentation set on the product CD-ROM. 

In addition to the complete documentation for the Oracle Enterprise Edition for 
Windows product, the following SQL*Plus documentation is available for 
online viewing:

■ SQL*Plus 9.2 Release Notes (for late-breaking information not included in the 
SQL*Plus documentation)

■ SQL*Plus User’s Guide and Reference

■ SQL*Plus Quick Reference

Examples in this book use the HR sample schema which is installed by default 
when you install Oracle9i. Refer to the Oracle9i Sample Schemas document for 
information on how this schema  was created and how you can use them.

In North America, printed documentation is available for sale in the Oracle Store at

http://oraclestore.oracle.com/

Customers in Europe, the Middle East, and Africa (EMEA) can purchase 
documentation from

http://www.oraclebookshop.com/

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes on the 
CD-ROM for late-breaking information. 
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Other customers can contact their Oracle representative to purchase printed 
documentation.

To download free release notes, installation documentation, white papers, or other 
collateral, please visit the Oracle Technology Network (OTN). You must register 
online before using OTN; registration is free and can be done at

http://otn.oracle.com/admin/account/membership.html

If you already have a username and password for OTN, then you can go directly to 
the documentation section of the OTN Web site at

http://otn.oracle.com/docs/index.htm

To access the database documentation search engine directly, please visit

http://tahiti.oracle.com

Whitepapers, sample code, frequently asked questions and other useful information 
are regularly posted to the SQL*Plus section on OTN at

http://otn.oracle.com/tech/sql_plus/

Conventions
This section describes the conventions used in the text and code examples of this 
documentation. It describes:

■ Conventions in Text

■ Conventions in Code Examples

■ Conventions for Windows Operating Systems
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Conventions in Text
We use various conventions in text to help you more quickly identify special terms. 
The following table describes those conventions and provides examples of their use.

Convention Meaning Example

Bold Bold typeface indicates terms that are 
defined in the text or terms that appear in 
a glossary, or both.

When you specify this clause, you create an 
index-organized table. 

Italics Italic typeface indicates book titles or 
emphasis.

Oracle9i Database Concepts

Ensure that the recovery catalog and target 
database do not reside on the same disk.

UPPERCASE 
monospace 
(fixed-width 
font)

Uppercase monospace typeface indicates 
elements supplied by the system. Such 
elements include parameters, privileges, 
datatypes, RMAN keywords, SQL 
keywords, SQL*Plus or utility commands, 
packages and methods, as well as 
system-supplied column names, database 
objects and structures, usernames, and 
roles.

You can specify this clause only for a NUMBER 
column.

You can back up the database by using the 
BACKUP command.

Query the TABLE_NAME column in the USER_
TABLES data dictionary view.

Use the DBMS_STATS.GENERATE_STATS 
procedure.

lowercase 
monospace 
(fixed-width 
font)

Lowercase monospace typeface indicates 
executables, filenames, directory names, 
and sample user-supplied elements. Such 
elements include computer and database 
names, net service names, and connect 
identifiers, as well as user-supplied 
database objects and structures, column 
names, packages and classes, usernames 
and roles, program units, and parameter 
values.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

Enter sqlplus to open SQL*Plus.

The password is specified in the orapwd file.

Back up the datafiles and control files in the 
/disk1/oracle/dbs directory.

The department_id, department_name, 
and location_id columns are in the 
hr.departments table.

Set the QUERY_REWRITE_ENABLED 
initialization parameter to true.

Connect as oe user.

The JRepUtil class implements these 
methods.

lowercase 
monospace 
(fixed-width 
font) italic

Lowercase monospace italic font 
represents placeholders or variables.

You can specify the managed_clause.

Run old_release.SQL where old_release 
refers to the release you installed prior to 
upgrading.
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Conventions in Code Examples
Code examples illustrate SQL, PL/SQL, SQL*Plus, or other command-line 
statements. They are displayed in a monospace (fixed-width) font and separated 
from normal text as shown in this example:

SELECT username FROM dba_users WHERE username = ’MIGRATE’;

The following table describes typographic conventions used in code examples and 
provides examples of their use.

Convention Meaning Example

[ ] Brackets enclose one or more optional 
items. Do not enter the brackets.

DECIMAL ( digits [ , precision ])

{ } Braces enclose two or more items, one of 
which is required. Do not enter the braces.

{ENABLE | DISABLE}

| A vertical bar represents a choice of two 
or more options within brackets or braces. 
Enter one of the options. Do not enter the 
vertical bar.

{ENABLE | DISABLE}

[COMPRESS | NOCOMPRESS]

... Horizontal ellipsis points indicate either:

■ That we have omitted parts of the 
code that are not directly related to 
the example

■ That you can repeat a portion of the 
code

CREATE TABLE ... AS subquery;

SELECT col1, col2, ... , coln FROM 
employees;

 .

 .

 .

Vertical ellipsis points indicate that we 
have omitted several lines of code not 
directly related to the example.

SQL> SELECT NAME FROM V$DATAFILE;
NAME
------------------------------------
/fsl/dbs/tbs_01.dbf
/fs1/dbs/tbs_02.dbf
.
.
.
/fsl/dbs/tbs_09.dbf

9 rows selected.

Other notation You must enter symbols other than 
brackets, braces, vertical bars, and ellipsis 
points as shown.

   acctbal NUMBER(11,2);

   acct    CONSTANT NUMBER(4) := 3;
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Italics Italicized text indicates placeholders or 
variables for which you must supply 
particular values.

CONNECT SYSTEM/system_password

DB_NAME = database_name

UPPERCASE Uppercase typeface indicates elements 
supplied by the system. We show these 
terms in uppercase in order to distinguish 
them from terms you define. Unless terms 
appear in brackets, enter them in the 
order and with the spelling shown. 
However, because these terms are not 
case sensitive, you can enter them in 
lowercase.

SELECT last_name, employee_id FROM 
employees;

SELECT * FROM USER_TABLES;

DROP TABLE hr.employees;

lowercase Lowercase typeface indicates 
programmatic elements that you supply. 
For example, lowercase indicates names 
of tables, columns, or files.

Note: Some programmatic elements use a 
mixture of UPPERCASE and lowercase. 
Enter these elements as shown.

SELECT last_name, employee_id FROM 
employees;

sqlplus hr/your_password

CREATE USER mjones IDENTIFIED BY 
your_password;

Convention Meaning Example
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Conventions for Windows Operating Systems 
The following table describes conventions for Windows operating systems and 
provides examples of their use.

Convention Meaning Example

Choose Start > How to start a program.  To start the Database Configuration Assistant, 
choose Start > Programs > Oracle - HOME_NAME 
> Configurtion and Migration Tools > Database 
Configuration Assistant.

File and directory 
names

File and directory names are not case 
sensitive. The following special characters 
are not allowed: left angle bracket (<), 
right angle bracket (>), colon (:), double 
quotation marks ("), slash (/), pipe (|), 
and dash (-). The special character 
backslash (\) is treated as an element 
separator, even when it appears in quotes. 
If the file name begins with \\, then 
Windows assumes it uses the Universal 
Naming Convention.

c:\winnt"\"system32 is the same as 
C:\WINNT\SYSTEM32

C:\> Represents the Windows command 
prompt of the current hard disk drive. 
Your prompt reflects the subdirectory in 
which you are working. Referred to as the 
command prompt in this guide.

C:\oracle\oradata>

Special characters The backslash special character (\) is 
sometimes required as an escape 
character for the double quote (") special 
character at the Windows command 
prompt. Parentheses and the single quote 
special character (’) do not require an 
escape character. See your Windows 
operating system documentation for more 
information on escape and special 
characters.

C:\>exp scott/tiger TABLES=emp 
QUERY=\"WHERE job=’SALESMAN’ and 
sal<1600\"

C:\>imp SYSTEM/ password 
FROMUSER=scott TABLES=(emp, dept)

HOME_NAME Represents the Oracle home name.

The home name can be up to 16 
alphanumeric characters. The only special 
character allowed in the home name is the 
underscore. 

C:\> net start Oracle HOME_
NAMETNSListener
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ORACLE_HOME 
and ORACLE_
BASE

In releases prior to Oracle8i release 
8.1.3, when you installed Oracle 
components, all subdirectories were 
located under a top level ORACLE_
HOME directory that by default was:

■ C:\orant for Windows NT

■ C:\orawin98 for Windows 98

or whatever you called your Oracle home.

This release complies with Optimal 
Flexible Architecture (OFA) 
guidelines.  All subdirectories are not 
under a top level ORACLE_HOME 
directory. There is a top level 
directory called ORACLE_BASE that 
by default is C:\oracle. If you 
install the latest Oracle releaseon a 
computer with no other Oracle 
software installed, then the default 
setting for the first Oracle home 
directory is C:\oracle\orann. 
where nn is hte latest release number. 
The Oracle home directory is located 
directly under ORACLE_BASE.

All directory path examples in this 
guide follow OFA conventions.

See Oracle9i Database Getting Started 
for Windows for additional 
information on OFA compliances and 
for information on installing Oracle 
products in non-OFA compliant 
directories.

Go to the ORACLE_BASE\ORACLE_
HOME\rdbms\admin directory.

Convention Meaning Example
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Documentation Accessibility
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.
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Introducing SQL*Plus

This chapter provides introductory information to help you get started with 
SQL*Plus.

Specific topics discussed are:

■ Overview

■ Basic Concepts

■ Obtaining Online Help
us 1-1



Overview
Overview
You can use SQL*Plus with SQL (Structured Query Language) and its procedural 
language extension, PL/SQL. These database languages allow you to store and 
retrieve data in Oracle databases. PL/SQL enables you to link several SQL 
commands through procedural logic.

SQL*Plus enables you to manipulate SQL commands and PL/SQL blocks, and to 
perform many additional tasks. With SQL*Plus, you can:

■ Enter, edit, store, retrieve, and run SQL commands and PL/SQL blocks.

■ Format, perform calculations on, store, and print query results in the form of 
reports.

■ List column definitions for any table.

■ Send messages to and accept responses from an end user.

■ Perform database administration.

The following three user interfaces and a user interface extension are available for 
SQL*Plus on Windows:

■ Command-line User Interface.

For information about command-line behavior specific to Windows, see 
Chapter 3, "Using SQL*Plus"

■ iSQL*Plus User Interface.

For information about the iSQL*Plus User Interface, see the SQL*Plus User’s 
Guide and Reference.

■ iSQL*Plus Extension for Windows (Windows only).

For information about the iSQL*Plus Extension for Windows, see Chapter 3, 
"Using SQL*Plus"

■ Graphical User Interface (Windows only).

The SQL*Plus for Windows Graphical User Interface (GUI) will be desupported 
in future releases of SQL*Plus. The browser-based iSQL*Plus User Interface will 
replace the SQL*Plus for Windows GUI. The SQL*Plus for Windows 
command-line (DOS) interface will continue to be supported. For information 
about the Windows GUI, see Chapter 3, "Using SQL*Plus".
1-2 SQL*Plus Getting Started
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Basic Concepts
The following definitions explain concepts central to SQL*Plus:

For definitions of other concepts that are relevant to SQL*Plus, see the glossary in 
the SQL*Plus User’s Guide and Reference.

Obtaining Online Help
Online help for SQL*Plus is available from the SQL*Plus command-line during a 
session. The SQL*Plus help tables must be created and populated by the database 
administrator. See "Installing SQL*Plus Command-line Help" on page 2-1 for 
information about installing SQL*Plus online help. 

iSQL*Plus online help and SQL*Plus command-line help are available from the 
iSQL*Plus user interface, see the SQL*Plus User’s Guide and Reference. 

Concept Definition

command An instruction you give to an operating system, or software 
such as SQL*Plus or Oracle, to perform a particular task. 

SQL command A command to execute SQL statements.

SQL*Plus command A command to execute SQL*Plus statements.

block In PL/SQL, a group of SQL and PL/SQL commands related 
to each other through procedural logic.

table The basic unit of storage in Oracle.

query A read only SQL SELECT command that retrieves 
information from one or more tables.

query results The data retrieved by a query. 

report Query results formatted by you through SQL*Plus 
commands.

SQL buffer A buffer which stores the last SQL command or PL/SQL 
block that you entered in SQL*Plus.

screen buffer A buffer to store the data in the SQL*Plus application 
window.
Introducing SQL*Plus 1-3
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Installing SQL*Plus Help and

Demonstration Tables

This chapter provides information to help you install SQL*Plus components in 
Windows environments.

Specific topics discussed are:

■ Installing SQL*Plus

■ Installing SQL*Plus Command-line Help

■ Accessing Sample Tables
les 2-1
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Installing SQL*Plus
The CD-ROM insert that accompanies your product CD-ROM includes the 
following information about SQL*Plus:

■ System requirements

■ Installation instructions 

Installing SQL*Plus Command-line Help
Command-line help is available from the graphical user interface, the 
command-line user interface and the iSQL*Plus user interface while you are using 
SQL*Plus. The database administrator creates the SQL*Plus help tables and 
populates them with SQL*Plus help data.

There is also iSQL*Plus online help available only from the iSQL*Plus user interface, 
see the SQL*Plus User’s Guide and Reference. 

Prerequisites
Before you can install SQL*Plus command-line help, ensure that:

■ SQL*Plus is installed, otherwise, you cannot create and load the help tables. 

■ The default tablespace for the SYSTEM user is large enough to accommodate 
the help system. 

■ The SQL*Plus help script files are available in 

%ORACLE_HOME%\SQLPLUS\ADMIN\HELP\ 

The help script files are:

■ HELPBLD.SQL – to drop and create new help tables. 

■ HELPUS.SQL – to populate the help tables with the help data. 

■ HELPDROP.SQL – to drop existing SQL*Plus help tables. 

■ The Windows command file, HELPINS.BAT, is available in

%ORACLE_HOME%\BIN\ 

Note: Before installing SQL*Plus, refer to the generic SQL*Plus 
documentation on the CD-ROM, and to the Release Notes on the 
CD-ROM for late-breaking information. 
2-2 SQL*Plus Getting Started
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Installing SQL*Plus Command-line Help
SQL*Plus command-line help is installed automatically during Oracle9i installation. 
There are also two ways to manually install SQL*Plus command-line help:

Running a provided batch file from the command prompt
1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 

with:

SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user. The 
default SYSTEM user password is MANAGER. 

The HELPINS utility reads this login from SYSTEM_PASS to run successfully.

2. Run the batch file, HELPINS.BAT, from a command-line prompt with:

C:\> %ORACLE_HOME%\BIN\HELPINS US

Running a provided SQL script from SQL*Plus
1. Run SQL*Plus as the SYSTEM user with:

C:\> SQLPLUS SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user.

2. Run the SQL script, HELPBLD.SQL, from SQL*Plus with:

SQL> @%ORACLE_HOME%\SQLPLUS\ADMIN\HELP\HELPBLD.SQL HELPPATH HELPUS.SQL

where HELPPATH is the path to the SQL*Plus help directory containing the file 
HELPUS.SQL. HELPPATH is usually:

%ORACLE_HOME%\SQLPLUS\ADMIN\HELP

Accessing SQL*Plus Help
To access SQL*Plus command-line help, enter the following command in SQL*Plus:

SQL> HELP

If you know the topic for which you want help, enter the following command:

SQL> HELP topic
Installing SQL*Plus Help and Demonstration Tables 2-3
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where topic is a SQL*Plus help topic. 

To display a list of available help topics, enter one of the following commands:

SQL> HELP INDEX

or

SQL> HELP TOPICS

Example
To get help for the COLUMN command, enter 

SQL> HELP COLUMN

If you get a response that help is unavailable, check that you have correctly installed 
SQL*Plus command-line help in the SYSTEM schema.

For more information about the HELP command, see the Help command in the 
SQL*Plus User’s Guide and Reference.

Accessing Sample Tables
Included with Oracle9i, are a number of sample schemas. The SQL*Plus examples 
use the EMP_DETAILS_VIEW view of the Human Resources (HR) sample schema. 
This schema contains personnel records for a fictitious company. For information 
about unlocking and accessing the HR sample schema, see Chapter 1 of the 
SQL*Plus User’s Guide and Reference. For further information about the sample 
schemas included with Oracle9i, see the Oracle9i Sample Schemas guide. 

Note: Dates in the sample schemas use four digit years. As the 
default date format in SQL*Plus is DD-MM-YY, dates displayed 
show only a two digit year. To control the way dates are displayed, 
either use ALTER SESSION SET NLS_DATE_FORMAT 
=’DD-MM-YYYY’, or use the SQL TO_CHAR function in your 
SELECT statements .
2-4 SQL*Plus Getting Started
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Using SQL*Plus

This chapter explains how to start and use SQL*Plus from both the command-line 
interface and the graphical user interface, and describes the graphical user interface 
menu options. It also describes how to use and configure the iSQL*Plus Extension 
for Windows.

Specific topics discussed are:

■ Using the Command-line Interface

■ Using the Graphical User Interface

■ Exiting SQL*Plus

■ iSQL*Plus Extension for Windows
*Plus 3-1
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Using the Command-line Interface
The SQL*Plus command-line interface is standard on all operating systems.

If you are connecting to a remote Oracle database, make sure your Oracle Net 
software is installed and working properly. For more information, see the Oracle9i 
Net Services Administrator’s Guide and the Oracle9i Database Administrator’s Guide for 
Windows. 

To start the SQL*Plus command-line interface:

1. Select Command Prompt from Programs (Programs/Accessories in Windows 
XP/2000) in the Start menu. A Command Prompt window appears.

2. Start SQL*Plus by entering

C:\> SQLPLUS

You can optionally include your login username and password separated by a 
slash (/), and a remote database name to connect to, for example:

C:\> SQLPLUS username/password@connect_identifier

Otherwise you will be prompted to enter your username and password. 

Interpreting Arguments in Windows
The rules for interpreting arguments in Windows commands are:

■ Arguments are delimited by white space.
3-2 SQL*Plus Getting Started
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■ A string surrounded by double quotation marks, for example, “this string”, is 
interpreted as a single argument.

■ A double quotation mark preceded by a backslash is interpreted as a literal 
double quotation mark.

Example
The following SET MARKUP command illustrates white space to separate 
arguments, the single string argument for HEAD surrounded by single quotes, and 
the escaped double quotes around Employees so that the characters are printed and 
not interpreted as string delimiters. 

SET MARKUP HTML HEAD ’<TITLE>Annual Report "Employees"</TITLE>’

For more information about SQL*Plus command-line arguments, see the SQL*Plus 
User’s Guide and Reference.

Changing the Command-line Font and Font Size
You can use the Windows Command Prompt Properties dialog to set the font and 
font size used in the SQL*Plus command-line interface. 

To Change the Command-line Interface Font and Font Size
1. Right click in the command-line interface title bar. 

2. Click Properties. The Window Preview box displays the current window’s 
relative size on your monitor based on your font and font size selections. The 
Selected Font: box displays a sample of the current font. 

3. Click the Font tab.

4. Select the font size to use from the Size box. Raster font sizes are shown as 
width by height in pixels. TrueType font sizes are shown as height in pixels.

5. Select the font to use from the Font box.

6. Select the Bold Fonts check box if you want to use a bold version of the font. 

For more information about changing Windows Command Prompt properties, see 
Windows Help or click Help in the Command Prompt Properties dialog. For 
information about changing font face and size in the Windows Graphical User 
Interface (GUI), see "Changing the GUI Font and Font Size" later in this chapter.
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Using a Special Character
To check if a font contains a particular character, for example, the Euro sign, enter 
the character’s decimal number equivalent in the SQL*Plus command-line interface. 
For example, the decimal number equivalent for the Euro sign is 128, so you would 
enter Alt+0128 (hold Alt while pressing 0, 1, 2 and 8) to display it. If it appears 
correctly, the font contains the Euro sign, otherwise you need to try another font. 

You can use the Windows Character Map utility to view the characters available in a 
font. Character Map also shows the decimal number equivalent for extended ASCII 
characters. You access the Character Map utility by selecting Start, Programs, 
Accessories and then clicking Character Map.

Using the Graphical User Interface
While the command-line interface is a standard feature of SQL*Plus on all operating 
system platforms, the graphical user interface is a feature of SQL*Plus only 
available in Windows. The Windows Graphical User Interface will be obsoleted in 
favor of the iSQL*Plus browser-based user interface in future releases of SQL*Plus. 

If you are connecting to a remote Oracle database, make sure your Oracle Net 
software is installed and working properly. For more information, see the Oracle9i 
Net Services Administrator’s Guide and the Oracle9i Database Administrator’s Guide for 
Windows.

The graphical user interface can be started from the Windows menus, or from a 
Windows command prompt.

Starting the GUI from the Windows Menu
1. Select Programs in the Start menu. Then select Oracle - ORACLE_HOME, then 

Application Development, and click SQL Plus.

The SQL*Plus window appears displaying the Log On dialog.
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Enter a valid user name and password. If you are connecting to a remote Oracle 
database, enter the Oracle Net connect_identifier in the Host String field. To 
connect to the default database, leave the Host String field blank. See the 
Oracle9i Net Services Administrator’s Guide for more information about 
configuring and using Oracle Net connect_identifiers.

2. Click OK.

Starting the GUI from the Windows Command Prompt
1. Select Command Prompt from Programs (Programs/Accessories in Windows 

XP/2000)  in the Start menu. A Command Prompt window appears.

2. Enter

C:\> SQLPLUSW

The SQL*Plus graphical user interface starts. The -LOGON option is not 
supported in the Windows GUI. You can optionally include your login 
username and password separated by a slash (/), and a remote database to 
connect to, for example:

C:\> SQLPLUSW username/password@connect_identifier

Otherwise enter the required information in the login dialog as described 
earlier. The Oracle SQL*Plus application window appears.
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Using the SQL*Plus Application Window
SQL*Plus displays the SQL command prompt in the application window.

To enter SQL and SQL*Plus commands, type each command at the SQL*Plus 
command prompt and press Enter.

Using the Mouse Buttons to Copy Text to the Command Prompt
You can use the mouse buttons to copy text from anywhere in the SQL*Plus 
interface to the SQL*Plus prompt in the same interface.

To copy text, select the text by clicking and dragging with the left mouse button. 
While still holding down the left mouse button, click the right mouse button. 
SQL*Plus copies the selected text to the SQL*Plus prompt.

Using the Command Keys
The following command keys have special functions in SQL*Plus:
 :

Key Function

Home Top of screen buffer 

End Bottom of screen buffer

Page Up Previous screen page

Page Down Next screen page

Ctrl+Page Up Show page on left of current screen page

Ctrl+Page Down Show page on right of current screen page

Alt+F3 Find

F3 Find next

Ctrl+C Cancels an operation running in SQL*Plus.

Ctrl+C Copies text - when no operations are running in SQL*Plus.

Ctrl+V Paste text 

Shift+Del Clear the screen and the screen buffer 
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Using the SQL*Plus Menus
This section describes menus in the SQL*Plus graphical user interface (GUI). 
Bracketed entries show keyboard shortcuts to that File Menu command. The 
rightmost column shows the equivalent command-line interface command where 
applicable.

File Menu
The File menu has the following options:

Option Description of File Menu Option Command-line

Open The Open option retrieves a previously stored command file.

If you supply no file extension, SQL*Plus looks for command files with the 
.SQL extension. The command file should contain a single SQL or PL/SQL 
statement. It should not contain multiple statements or SQL*Plus 
commands.

GET filename

Save The Save option has three alternatives: Save Create, Save Replace, and Save 
Append.

SAVE

■ Save Create saves the contents of the SQL*Plus buffer in a command 
file. By default, SQL*Plus assigns the .SQL extension to command files. 
You can specify a different extension in the File name text box.

■ Save Replace replaces the contents of an existing file with the contents 
of the SQL*Plus buffer. SQL*Plus creates the file if it does not exist.

■ Save Append adds the contents of the SQL*Plus buffer to the end of the 
file you specify.

SAVE filename 
CREATE

SAVE filename 
REPLACE

SAVE filename 
APPEND

After you save a command file, you can:

■ Retrieve the file using the Open option on the File menu.

■ Edit the file using the Editor option on the Edit menu.

■ Run the file using the START or RUN commands from the SQL*Plus 
command prompt.

Save As The Save As option saves the contents of the SQL*Plus buffer in a command 
file.

By default, SQL*Plus assigns the .SQL extension to command files. You can 
specify a different extension in the File name text box.

SAVE filename

Spool The Spool option has two alternatives: Spool File and Spool Off. SQL*Plus 
for Windows does not support the SPOOL OUT clause.
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Edit Menu
The Edit menu has the following options:

■ Spool File stores query results in a file. By default, SQL*Plus assigns the 
.LST extension to spool files. You can specify a different extension in the 
File name text box. You can edit the results with the Editor option on 
the Edit menu, and print the file from a Windows text editor.

■ Spool Off turns off spooling.

SPOOL filename

SPOOL OFF

Run The Run option lists and executes the SQL command or PL/SQL block 
currently stored in the SQL buffer.

RUN

Cancel
(CTRL+C)

The Cancel option cancels an in-progress operation.

The Cancel keyboard shortcut is only available when a SQL*Plus operation 
is running in the SQL*Plus session. When no SQL*Plus operation is running, 
CTRL+C copies selected text.

Ctrl-C

Exit The Exit option commits all pending database changes and closes the 
SQL*Plus application window.

EXIT

Option Description of Edit Menu Option Command-line

Copy
(CTRL+C)

The Copy option copies selected text to the Clipboard.

After you copy text to the Clipboard, you can paste the text into other 
Windows applications, such as Microsoft Excel and Microsoft Word.

The Copy keyboard shortcut is only available when no SQL*Plus operations 
are running in the SQL*Plus session. When a SQL*Plus operation is running, 
CTRL+C cancels the running operation.

not applicable

Paste
(CTRL+V)

The Paste option pastes the contents of the Clipboard to the SQL*Plus 
command-line.

Note: A maximum of 3625 characters can be pasted from the Clipboard to 
the SQL*Plus command-line during a single paste operation.

not applicable

Clear
(SHIFT+DEL)

The Clear option clears the screen buffer and the screen of the SQL*Plus 
application window.

CLEAR SCREEN

Editor The Editor option has two alternatives: Invoke Editor and Define Editor.

■ Invoke Editor loads the contents of the SQL*Plus buffer into an editor. 
By default, SQL*Plus saves the file to AFIEDT.BUF. You can specify a 
different file name in the editor.

■ Define Editor defines the editor that is invoked.

EDIT

DEFINE _EDITOR
= editor name

Option Description of File Menu Option Command-line
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Search Menu
The Search menu has the following options:

Options Menu
The Options menu has the following options:

Option Description of Search Menu Option Command-line

Find
(ALT+F3)

The Find option searches for a character, a word, or a group of characters or 
words in the SQL*Plus application window. Find begins the search at the top 
of the displayed screen.

Note: When Find reaches the end of the displayed screen, it does not wrap 
and continue searching from the top of the screen buffer.

not applicable

Find Next
(F3)

The Find Next option finds the next occurrence of the search text. not applicable

Option Description of Options Menu Option Command-line

Environment The Environment option enables you to set system variables to alter the 
SQL*Plus environment for your current session. This dialog has three areas: 
Set Options, Value, and Screen Buffer.

Note: See "Setting Options and Values Using the Environment Dialog" on 
page 3-10 for examples of how these controls interact.

Set Options

This area has a list of variables you can select to establish aspects of the 
SQL*Plus environment for your current session, such as:

■ Setting the display width for NUMBER data.

■ Setting the display width for LONG data.

■ Enabling or disabling the printing of column headings.

■ Setting the number of lines in each page.

See the “Command Reference” chapter in the SQL*Plus User’s Guide and 
Reference for descriptions of each system variable in the SET command.

SET variable value

Value

The Value area has four options: Default, Custom, On, and Off.

Note: When Custom is selected, the On and Off buttons and the text field 
may or may not be enabled for user selection. The availability of these fields 
depends on the item selected in the Set Option. 

SET variable value
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Help Menu
The Help menu has the following option:

Setting Options and Values Using the Environment Dialog
Choose Environment from the Options menu to display the Environment dialog 
which you can use to create a SQL environment statement for the current session. 

Choose an item from the Set Options list to begin. You can use the default settings, 
or you can customize the settings by using the other dialog controls. The available 
controls vary with the options you choose. You can make multiple changes to 
options and values. When the text box is available, you can enter appropriate text or 
appropriate numeric values. Click OK to commit your settings. 

Screen Buffer

This area has two text boxes: Buffer Width and Buffer Length.

SET variable value

■ In the Buffer Width text box, you set the number of characters that 
SQL*Plus displays on one line. If you enter a number smaller than the 
length of output data, SQL*Plus truncates the data to match the buffer 
width you specified. The default value of the Buffer Width parameter is 
100 characters. You can specify from 80 to 1000 characters on one line.

■ In the Buffer Length text box, you set the number of lines that SQL*Plus 
displays on the screen. If SQL*Plus displays more lines of data than you 
specify, the remaining lines of data will “wrap around” to the top of the 
screen buffer. The default value of the Buffer Length parameter is 1000 
lines. You can specify from 100 to 2000 lines on one screen.

Notes: When you change the Screen Buffer option, SQL*Plus displays a 
dialog to alert you that if you shorten the size of your screen buffer, some 
data may not be displayed on your screen. Click OK to proceed.

If you use SET MARKUP to send output to a HTML table, the number of 
lines specified in the Buffer Length variable specifies the number of HTML 
table rows. Each HTML table row may contain more than one text line.

Option Description of Help Menu Option Command-line

About 
SQL*Plus

Displays the SQL*Plus version number and copyright information.

You access SQL*Plus help from the SQL*Plus prompt. See "Accessing 
SQL*Plus Help" on page 2-1.

not applicable

Option Description of Options Menu Option Command-line
3-10 SQL*Plus Getting Started



Using the Graphical User Interface
Example 3–1

The ARRAYSIZE is set to 15, the default value. 

To change the ARRAYSIZE, click Custom and enter the number in the text box.

Note: Options introduced in SQL*Plus Release 8.1 can only be 
accessed through the command-line and are not available in the 
SQL*Plus for Windows Environment dialog. These options are:

SET APPINFO

SET LOBOFFSET

SET MARKUP

SET SHIFTINOUT

SET SQLBLANKLINES

SET SQLPLUSCOMPATIBILITY {ON|OFF}

See “Command Reference” in the SQL*Plus User’s Guide and 
Reference for descriptions of these SET commands.
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Example 3–2

The default for ECHO is off. To change the setting, click Custom and then click 
On. 

Changing the GUI Font and Font Size
There are three registry entries that set the font and font size used in the SQL*Plus 
Windows GUI. SQLPLUS_FONT sets the font face, and SQLPLUS_FONT_SIZE 
sets the font size in pixels. For Windows NT/98, SQLPLUS_FONT_CHARSET sets 
the font subset to use. If not set, the default font subset is used. It may be important 
to set the SQLPLUS_FONT_CHARSET registry entry particularly when specifying 
a font to support a national language. Not all font subsets may contain the 
characters you expect or want to make available. 

You use the Windows Registry Editor to create these three registry entries and 
define values for them. Ensure that you create the correct entries in uppercase, and 
that the values (font names, sizes, subset names) you enter are correct. If you enter 
an incorrect name, the default font Fixedsys, and size 16, are used. If you enter an 
incorrect font subset name, the default subset is used.
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You can choose any fixed-pitch TrueType font available in your Windows system 
such as Courier New or Lucida Console. If you choose a proportional pitch font 
such as Arial or Times New Roman, or if you enter an unavailable font, the registry 
entry is ignored and the default font and size, Fixedsys 16, are used. If you choose 
an unavailable font size, the default font size, 16, is used. If you choose an 
unavailable font subset, the default subset for the selected font is used.

If you do not create the SQLPLUS_FONT registry entry, or if you do not specify a 
value for SQLPLUS_FONT, the default font and size, Fixedsys 16, are used.

If you want to use particular characters, such as the Euro sign, you should make 
sure that the fixed pitch font you choose contains those characters. 

To Change the Windows GUI Font and Font Size
1. Select Run from the Start menu and then enter regedit in the Open field. 

2. Click OK to start the Registry Editor. The Registry Editor is displayed.

3. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0.

4. Click New String Value in the Edit menu. A new string value, with the default 
name, NewValue #1 is created at the bottom of the right pane of the Registry 
Editor. The default name of the new string value is selected ready for you to 
replace with the name you want. 

Warning: Microsoft does not recommend modifying the registry. 
Editing the registry may affect your operating system and software 
installation. Only advanced users should edit the registry. Oracle 
takes no responsibility for problems arising from editing the 
Windows registry. 

Note: If you have more than one Oracle installation, you must 
select the HOME entry associated with the Windows GUI you want 
to change. HOME0 is the registry entry for an Oracle installation. A 
subsequent Oracle installation will have the registry entry HOME1 
and the next HOME2 and so on. 

Changes only affect a SQL*Plus Windows GUI started from the 
associated Oracle installation, so you can use different settings for 
each Oracle installation.
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5. Enter SQLPLUS_FONT as the name of the new font face string value. If you 
miskey the name or inadvertently enter it in mixed or lower case, you can edit 
the name by selecting Rename from the Edit menu.

or

Enter SQLPLUS_FONT_SIZE as the name of the new font size string value. If 
you miskey the name or inadvertently enter it in mixed or lower case, you can 
edit the name by selecting Rename from the Edit menu.

or

Enter SQLPLUS_FONT_CHARSET as the name of the new font subset string 
value. If you miskey the name or inadvertently enter it in mixed or lower case, 
you can edit the name by selecting Rename from the Edit menu.

6. Click Modify from the Edit menu or press Enter again to display the Edit String 
dialog.

7. Enter the font name you want to use, such as Courier New, in the Value Data: 
field. SQL*Plus will use the new font the next time you start the SQL*Plus 
Windows GUI. The font be a True Type fixed pitch font such as Courier New or 
Lucida Console.

or

Enter the font size you want to use in pixels, such as 14, in the Value Data: field. 
SQL*Plus will use the new font size the next time you start a SQL*Plus 
Windows GUI. The size must be a size that exists on the client machine for the 
specified font) 

or

For Windows NT/98, enter the font subset you want to use, such as TURKISH, 
in the Value Data: field. SQL*Plus will use the new font subset the next time 
you start a SQL*Plus Windows GUI. While there may be other font subsets 
available if you have installed additional fonts, the following valid values for 
SQLPLUS_FONT_CHARSET are available:

DEFAULT
SYMBOL
SHIFTJIS
HANGEUL
GB2312
CHINESEBIG5
OEM
JOHAB
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HEBREW
ARABIC
GREEK
TURKISH
VIETNAMESE
THAI
EASTEUROPE
RUSSIAN
MAC
BALTIC

Using a Special Character
To check if a font contains a particular character such as the Euro sign, enter the 
character’s decimal number equivalent in the SQL*Plus Windows GUI. For 
example, the decimal number equivalent for the Euro sign is 128, so you would 
enter Alt+0128 (hold Alt while pressing 0, 1, 2 and 8) to display it. If it appears 
correctly, the font contains the Euro sign, otherwise you need to try another font. 

You can also use the Windows Character Map accessory to view the characters 
available in a font. Character Map also shows the decimal number equivalent for 
extended ASCII characters. You access the Character Map accessory by selecting 
Start, Programs, Accessories and then Character Map. 

Exiting SQL*Plus
You enter EXIT or QUIT at the SQL*Plus prompt to exit SQL*Plus from the 
command-line interface or from the GUI.

You return to the Windows Command Prompt when you exit either the 
command-line interface, or the GUI if you started it from the command-line with 
SQLPLUSW. 

Click Exit from the File menu to exit from the GUI. The GUI closes and you return 
to Windows when you exit SQL*Plus from the GUI.

Note: You should not change the font face, font size or font subset 
while any SQL*Plus Windows GUI is active. You should exit all 
SQL*Plus Windows GUI sessions, make font face, font size and font 
subset changes in the registry, exit the Registry Editor and then 
restart the SQL*Plus Windows GUI to see the changes. 
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iSQL*Plus Extension for Windows
The iSQL*Plus Extension for Windows provides a context menu to load or execute 
local SQL scripts in iSQL*Plus. The iSQL*Plus Extension for Windows works with 
.SQL files and is activated by right clicking a .SQL file in Windows Explorer. 

The utility is installed during Oracle9i Database and Oracle9i Client for Windows  
installations. After installation, you can configure access to one or more iSQL*Plus 
Servers. For more information about the iSQL*Plus User Interface, see the SQL*Plus 
User’s Guide and Reference.

Context Menu
After you have configured an iSQL*Plus Server, you can use the context menu to: 

■ Run or load local scripts accessible from your workstation

■ Select the server to use from a list of configured iSQL*Plus Servers

■ Choose the double click file association for .SQL files

■ Choose the language to use from a list of configured languages

The following shows a typical view of the context menu with iSQL*Plus Servers 
configured. 

The highlighted iSQL*Plus Server is configured to start iSQL*Plus in a browser and 
load MIS_Reports.sql into the Input area of the iSQL*Plus Server named Employee_
LA.
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Configuring the iSQL*Plus Extension
The iSQL*Plus Extension for Windows is accessed through extended menus in 
Windows platforms. The iSQL*Plus Extension for Windows extended menu is 
accessed by right clicking files with the .SQL file extension. 

If you have installed the Oracle9i Server, iSQL*Plus Server entries for your Oracle 
HTTP Server are created by default. If you have installed the Oracle9i Client, no 
iSQL*Plus Server entries are created. You can use the Configuration dialog to 
configure the available iSQL*Plus Servers that you want.

The Configuration Dialog
Open the Configuration dialog by right clicking a .SQL file in Windows Explorer, 
then select iSQL*Plus Servers, and then Configure. The Configure iSQL*Plus 
Servers dialog is displayed. 

When the column is narrower than the field it contains, tool tips show the full text 
in the field, but to edit or copy a field, make sure that the column width is wide 
enough to display the full field. You can widen the column by selecting and 
dragging the heading column separator.

You can sort the list of iSQL*Plus Servers in ascending or descending field name 
order by clicking the field name column heading. You can also manually sort the 
server definitions by using the up and down arrow buttons on the right side of the 
list of iSQL*Plus Servers.

URL  Enter a valid iSQL*Plus Server URL in the form:

http://host.domain/isqlplus

This field is mandatory.
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Name  Enter a name for this iSQL*Plus Server. The name, if entered, is used in the 
context menu, otherwise the full iSQL*Plus Server URL is used. 

Connect String  Enter a connect string to specify your username and password and 
the database you want to connect to. If you omit a username and password you are 
prompted for them when iSQL*Plus starts. If you omit a database connection 
identifier or Oracle Net alias, you are connected to the default database. 

Execute  Clear the Execute checkbox to change the action performed on the selected 
file. The default action is Execute, the alternative is Load. Execute runs the selected 
file in the iSQL*Plus Server and displays the results in your browser. Load opens 
the iSQL*Plus Server and loads the selected file into the Input area.

Add  Click Add to add a new iSQL*Plus Server. 

Remove  Click Remove to delete a selected iSQL*Plus Server definition.

File Association:  Enter a path and arguments for the application you want to 
associate with the .SQL file extension when you double click. The default 
application is Windows Notepad. This definition does not affect the iSQL*Plus 
Server definitions. 

Browse  Click Browse to find an application you want to associate with the .SQL file 
extension when you double click. 

Language:  Select a language you want to use in the iSQL*Plus Extension from the 
Language box:

Brazilian Portuguese
English 
French/Canadian French
German
Italian
Japanese
Korean
Simplified Chinese
Spanish/LA Spanish
Traditional Chinese

This language setting only affects the iSQL*Plus Extension, not iSQL*Plus. 
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OK  Click OK to save your changes and close the Configure iSQL*Plus Servers 
dialog. 

Cancel  Click Cancel to quit your changes and close the Configure iSQL*Plus Servers 
dialog. You are prompted once more before your changes are lost.

When you first open the Configure iSQL*Plus Servers dialog, the OK button is 
unavailable and the Cancel button is labelled Close. Once you make changes, OK is 
enabled and Close is renamed Cancel. 

Adding a Server
You must configure at least one iSQL*Plus Server before you can use the iSQL*Plus 
Extension. To add an iSQL*Plus Server, perform the following steps:

1. Right click a .SQL file in Windows Explorer.

2. Select iSQL*Plus Servers to display the context menu options. Initially, there 
are the following options:

■ No iSQL*Plus Servers configured 

If you have installed Oracle9i Server, there are two iSQL*Plus Servers 
configured, one for the standard URL and one for the DBA URL.

■ Configure. 

■ About iSQL*Plus Extension.

3. Click Configure. The Configure iSQL*Plus Servers dialog is displayed.

4. Enter an iSQL*Plus Server definition in the iSQL*Plus Servers: area. When you 
first open the dialog, the following syntax model is displayed to show you the 
expected field contents:

URL: << http://host.domain/isqlplus >>
Name: << host >>
Connect String: << username/password@connect_identifier >> 

You must enter a URL for your iSQL*Plus Server, the other fields are optional. 
This may be different if iSQL*Plus Servers have been configured during an 
Oracle9i Server installation.

5. Click OK to save your new server definition. 

The new iSQL*Plus Server Name appears in the context menu. When you select a 
server from the context menu, the full iSQL*Plus Server URL is shown in the status 
bar. 
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Modifying a Server
To modify an iSQL*Plus Server, perform the following steps:

1. Right click a .SQL file in Windows Explorer.

2. Select iSQL*Plus Servers to display the context menu options.  

3. Click Configure. The Configure iSQL*Plus Servers dialog is displayed.

4. Select the server you wish to modify from the list of available servers.

5. Edit the server definition directly in the text fields and press Enter when you 
have finished editing each field. To edit or copy a field when the column is 
narrower than the field it contains, you need to widen the column by selecting 
and dragging the heading column separator.

6. Click OK to save your changes. 

The modified iSQL*Plus Server name appears in the context menu.

Removing a Server
Select the server you wish to remove from the list of available servers. The server’s 
details will appear in the following text boxes. Click the Remove button to remove it 
from the list of available servers. 

To remove an iSQL*Plus Server, perform the following steps:

1. Right click a .SQL file in Windows Explorer.

2. Select iSQL*Plus Servers to display the context menu options. 

3. Click Configure. The Configure iSQL*Plus Servers dialog is displayed.

4. Select the server you wish to remove from the list of available servers.

5. Click Remove.

6. Click OK to save your changes. 

The iSQL*Plus Server is removed from the context menu.
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Operating System-Specific References

This chapter provides the operating system-specific information that is referenced 
in the SQL*Plus User’s Guide and Reference.

Specific topics discussed are:

■ Automatic Login

■ TIMING Command

■ Interpreting Error Messages

■ Setting Up Your SQL*Plus Environment

■ Sending Results to a File

■ @, @@, and START Commands

■ HOST Command

■ SET NEWPAGE Command

■ PRODUCT_USER_PROFILE Table
ences 4-1
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Automatic Login
When connecting to an Oracle database on the same Windows computer, you can 
set up SQL*Plus to do an automatic login by following these steps:

1. Create an account in the database <PREFIX>USERX for every Windows user 
(USERX) who needs access to the database. <PREFIX> is the parameter OS_
AUTHENT_PREFIX in the initialization parameter file for the database (the 
default is OPS$). See the Oracle9i Database Reference and the Oracle Advanced 
Security Administrator’s Guide for more information about the OS_AUTHENT_
PREFIX initialization parameter.

2. After logging on to Windows as USERX, you can log in to SQL*Plus using / 
(slash) instead of username/password.

See “Shortcuts to Starting SQL*Plus” in Chapter 4 of the SQL*Plus User’s Guide and 
Reference which refers you to this guide for information about automatically logging 
on to SQL*Plus when you log on to your operating system.

TIMING Command
The SQL*Plus TIMING command displays output in hours, minutes, seconds and 
hundredths of seconds. For example, 02:31:07.55 is 2 hours, 31 minutes and 7.55 
seconds. 

See “Collecting Timing Statistics on Commands You Run” in Chapter 9 "Tuning 
SQL*Plus" and the  “SET” and “TIMING” commands in Chapter 13 "Command 
Reference" of the SQL*Plus User’s Guide and Reference which discuss how to use the 
TIMING command and the SET TIMING command to record timing data for an 
elapsed period.

Interpreting Error Messages
See “Interpreting Error Messages” in Chapter 5 of the SQL*Plus User’s Guide and 
Reference and this guide for information about interpreting error messages. See the 
SQL*Plus User’s Guide and Reference to find explanations and actions for error 
messages with SP2- amd CPY- prefixes. See the Oracle9i Database Error Messages to 
find explanations and actions for error codes with prefixes ORA-, TNS- and  PLS-.

If you do not find the error code in Oracle9i Database Error Messages, see Oracle9i 
Database Administrator’s Guide for Windows.
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Setting Up Your SQL*Plus Environment
When you install SQL*Plus, LOGIN.SQL is copied to the DBS subdirectory, and 
GLOGIN.SQL is copied to the SQLPLUS\ADMIN subdirectory of your Oracle 
home directory.

If you modify LOGIN.SQL or GLOGIN.SQL, make sure you do not add any ANSI 
escape sequences.

See "SQL*Plus Configuration"  in Chapter 3 of the SQL*Plus User’s Guide and 
Reference, which describes the LOGIN.SQL and GLOGIN.SQL files.

Sending Results to a File
When you use the SPOOL command from the graphical user interface or the 
command-line interface, SQL*Plus adds .LST to the file name if you do not specify 
an extension.

The SPOOL command is available from the File menu in the SQL*Plus graphical 
user interface. See "File Menu" on page 3-7 for more information.

SQL*Plus does not support the use of the SPOOL OUT clause in the command-line. 

See “Sending Results to a File” in Chapter 7 and “SPOOL” in Chapter 13 of the 
SQL*Plus User’s Guide and Reference, for more information about the SPOOL 
command.

@, @@, and START Commands
SQL*Plus searches the current default directory for the file name that you specify 
with the @, @@, or START command. If SQL*Plus cannot find this file, the program 
searches a path to find the file.

You can specify the path that SQL*Plus searches by modifying the SQLPATH 
parameter in your registry. For more information about the SQLPATH parameter, 
see the "SQLPATH Registry Entry" on page A-1.

See the sections “@ (at sign)”, “@@ (double at sign)”, and “START” in Chapter 13 of 
the SQL*Plus User’s Guide and Reference, which describe how SQL*Plus searches for a 
file when you use the @, @@, or START command.
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HOST Command
In SQL*Plus command-line and graphical user interfaces, you can access the 
Windows command prompt by entering the HOST command or a dollar sign ($) at 
the SQL*Plus prompt.

To return to SQL*Plus from the Windows command prompt, enter EXIT.

See “HOST” in Chapter 13 of the SQL*Plus User’s Guide and Reference, which 
describes how to use the HOST command to execute a host operating system 
command without leaving SQL*Plus.

SET NEWPAGE Command
The SET NEWPAGE 0 command does not clear the screen between pages. Instead, a 
black box appears in the GUI, or another character in the command-line interface.

See “SET” in Chapter 13 of the SQL*Plus User’s Guide and Reference, which describes 
how to set the NEWPAGE system variable, as well as many other system variables. 
It is recommended that you use SET NEWPAGE NONE.

PRODUCT_USER_PROFILE Table
The PRODUCT_USER_PROFILE (PUP) table provides product-level security that 
supplements the user-level security provided by the SQL GRANT and REVOKE 
commands and user roles.

To create the PUP table

Log in to SQL*Plus as the SYSTEM user and run PUPBLD.SQL which is located 
in the ORACLE_HOME\SQLPLUS\ADMIN directory with:

 SQL> @%ORACLE_HOME%\SQLPLUS\ADMIN\PUPBLD.SQL 

or

1. Set an environment variable, SYSTEM_PASS, to hold the SYSTEM user login 
with:

C:\> SET SYSTEM_PASS=SYSTEM/PASSWORD

where PASSWORD is the password you have defined for the SYSTEM user. The 
default SYSTEM user password is MANAGER. 

PUPBLD.BAT reads this login from SYSTEM_PASS to run successfully.
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2. Run the batch file, PUPBLD.BAT, from a command-line prompt with:

C:\> %ORACLE_HOME%\BIN\PUPBLD.BAT

If you are using SQL*Plus with a remote database, you may want to install the PUP 
table on the remote database. To do this, run PUPBLD.SQL on the server directly, or 
set the LOCAL parameter in your registry to point to the remote database and then 
run PUPBLD.SQL.

See the “PRODUCT_USER_PROFILE Table” in Chapter 10, "SQL*Plus Security" of 
the SQL*Plus User’s Guide and Reference for a description of the PUP table.

The PUP table is not used for ODBC connections. If you are unsure, you can usually 
identify ODBC connections from the form of the connection identifier. For ODBC 
connections, the connection identifier begins with odbc: or oca:. 
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A
Customizing Operating System Parameters

This chapter describes how to customize your SQL*Plus configuration by setting 
Windows registry entries and by changing the SQLPATH environment variable..

Specific topics discussed are:

■ Using the Registry

■ SQLPATH Registry Entry

■ SQLPLUS_FONT Registry Entry

■ SQLPLUS_FONT_SIZE Registry Entry

■ SQLPLUS_FONT_CHARSET Registry Entry

■ iSQL*Plus Extension for Windows Registry Entries

■ SQLPLUS Environment Variable

Warning: Microsoft does not recommend modifying the registry. 
Editing the registry may affect your operating system and software 
installation. Only advanced users should edit the registry. Oracle 
takes no responsibility for problems arising from editing the 
Windows registry. 
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Using the Registry
When you install Oracle products for Windows, Oracle Universal Installer adds 
relevant parameters to the Windows registry.

The following table indicates which registry version(s), REGEDT32.EXE or 
REGEDIT.EXE, you can use for your particular Windows platform: 

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE subkey contains the Oracle 
parameters.

See the Registry Editor’s help system for instructions on how to edit the registry 
entries defining Oracle parameters.

If you change the value of an Oracle related registry entry or add a registry entry, 
the change takes effect when SQL*Plus executes a procedure that uses the registry 
entry.

SQLPATH Registry Entry
The SQLPATH registry entry specifies the location of SQL scripts. SQL*Plus 
searches for SQL scripts in the current directory and then in the directories specified 
by the SQLPATH registry entry.

The HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\HOME0 registry subkey 
contains the SQLPATH registry entry. SQLPATH is created with a default value of 
\ORACLE\ORA90\DBS. You can specify any directories on any drive as valid 
values for SQLPATH.

When setting the SQLPATH registry entry, you can concatenate directories with a 
semicolon (;). For example:

C:\ORACLE\ORA90\DATABASE;C:\ORACLE\ORA90\DBS

See the Registry Editor’s help system for instructions on how to edit the SQLPATH 
registry entry.

Windows Platform REGEDT32.EXE REGEDIT.EXE

Windows XP Pro YES YES

Windows 2000 YES YES

Windows NT 4.0 YES YES

Windows 98 NO YES
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SQLPLUS_FONT Registry Entry
The SQLPLUS_FONT registry entry defines the font face used in the SQL*Plus 
Windows GUI. It is located in the registry subkey, HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0. If the SQLPLUS_FONT entry is not created, 
or if it has an invalid name or value, the default face, Fixedsys, is used. 

See "To Change the Windows GUI Font and Font Size" on page 3-13 for details on 
how to create the SQLPLUS_FONT registry entry and set the font face. See the 
Registry Editor’s help system for instructions on how to edit the SQLPLUS_FONT 
registry entry.

SQLPLUS_FONT_SIZE Registry Entry
The SQLPLUS_FONT_SIZE registry entry defines the font size used in the SQL*Plus 
Windows GUI. It is located in the registry subkey, HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0. If the SQLPLUS_FONT_SIZE entry is not 
created, or if it has an invalid name or value, the default size, 16, is used. 

See "Changing the GUI Font and Font Size" on page 3-12 for details on how to create 
the SQLPLUS_FONT_SIZE registry entry and set the font size. See the Registry 
Editor’s help system for instructions on how to edit the SQLPLUS_FONT_SIZE 
registry entry.

SQLPLUS_FONT_CHARSET Registry Entry
The SQLPLUS_FONT_CHARSET registry entry only affects the font subset used in 
the SQL*Plus Windows GUI on Windows NT/98 where Microsoft font support has 
been separarately installed. 

The SQLPLUS_FONT_CHARSET registry entry defines the font subset used in the 
SQL*Plus Windows GUI. It allows special characters to be displayed in the correct 
subset of the given font. It is located in the registry subkey, HKEY_LOCAL_
MACHINE\SOFTWARE\ORACLE\HOME0. If the SQLPLUS_FONT_CHARSET entry is 
not created, or if it has an invalid name or value, the default font subset is used. 

See "Changing the GUI Font and Font Size" on page 3-12 for details on how to create 
and set the SQLPLUS_FONT_CHARSET registry entry. See the Registry Editor’s 
help system for instructions on how to edit the SQLPLUS_FONT_CHARSET 
registry entry.
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iSQL*Plus Extension for Windows Registry Entries
The iSQL*Plus Extension for Windows is installed, and associated registry entries 
created, as part of an Oracle9i installation. If you have installed Oracle9i Server, the 
following registry entries are created:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers\Server00 
HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers\Server01

If you have installed Oracle9i Client, only the following registry entry is created:

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus contains a ServerCount 
variable which counts the number of configured iSQL*Plus Servers.  Each time you 
configure another iSQL*Plus Server, another registry entry is created to represent 
that entry and the ServerCount variable is incremented by one. 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers is a container 
for the two iSQL*Plus Servers configured in an Oracle9i Server installation, or it is 
created when you configure an iSQL*Plus Server in an Oracle9i Client installation.

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers\Server00  is 
the first iSQL*Plus Server configured during an Oracle9i Server installation. It has a 
URL of the form: 

http://machine_name.domain:port/isqlplus 

HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\iSQLPlus\Servers\Server01 is 
the second iSQL*Plus Server configured during an Oracle9i Server installation. It 
has the DBA user URL of the form: 

http://machine_name.domain:port/isqlplusdba 

SQLPLUS Environment Variable
The SQLPLUS environment variable specifies the location of SQL*Plus message 
files. This environment variable is set during installation and has a default value of

%ORACLE_HOME%/SQLPLUS/MESG

You should not modify or set this environment variable. 
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Symbols
$ command, 4-4
@ command, 4-3
@@ command, 4-3

A
accessing sample tables, 2-4
add server to iSQL*Plus extension, 3-18, 3-19
AFIEDT.BUF

See editor
ANSI escape sequences, warning about, 4-3
automatic login, 4-2

B
basic concepts, 1-3
block, defined, 1-3
buffer

clearing your screen, 3-8
screen, 1-3
screen area, 3-10
SQL, 1-3, 3-7

C
C:\ORANT, defined, -xv
C:\ORAWIN95, defined, -xv
cancelling an in-progress operation, 3-8
CD-ROM contents, -ix, 2-2
Character Map Windows utility

choosing a font, 3-4, 3-15
clearing your screen, 3-8

command files
opening, 3-7
saving, 3-7

command keys, SQL*Plus Windows GUI, 3-6
command-line interface, 3-2

changing face and size, 3-3
Euro sign, 3-4
special character, 3-4
Windows Character Map utility, 3-4

commands
copying text, 3-6
defined, 1-3
finding text, 3-9
HOST, 4-4
pasting text, 3-8
SET NEWPAGE, 4-4
SET TIMING, 4-2
windows arguments, 3-2

configuring the iSQL*Plus extension, 3-17
connect string

Also See connect_identifier
iSQL*Plus extension, 3-18

connect_identifier, 3-5
context menu

iSQL*Plus extension, 3-16
copying text, 3-6, 3-8
CPY error messages, 4-2

D
demonstration tables, 2-4
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E
Edit menu, 3-8
editor

defining, 3-8
invoking, 3-8
registry entries, A-2

environment
command, 3-9
setting up SQL*Plus, 3-9, 4-3
SQLPLUS variable, A-4

error messages, interpreting, 4-2
Euro sign

command-line interface, 3-4
GUI, 3-13, 3-15

execute
iSQL*Plus extension, 3-18

exiting
SQL*Plus, 3-15
SQL*Plus GUI, 3-8

extension for iSQL*Plus, 3-16

F
file association

setting for Windows, 3-18
File menu, 3-7
finding text, 3-9
font

changing face and size in command-line, 3-3
changing face and size in GUI, 3-12, 3-13
changing in GUI, 3-12
euro sign in command-line, 3-4
fixed pitch TrueType, 3-13
Oracle home, 3-13
setting default in GUI, A-3
setting default size in GUI, A-3
setting default subset in GUI, A-3
special character in command-line, 3-4
Windows Character Map utility, 3-4

G
GLOGIN.SQL file, 4-3
graphical user interface

See GUI

GUI
changing face and size, 3-12, 3-13
changing font, 3-12
menus, 3-7
Windows Character Map utility, 3-15

H
help

accessing online help, 2-3
installation prerequisites, 2-2
installing, 2-2
menu, 3-10

HOST command, 4-4
host string, 3-5

I
installing SQL*Plus online help, 2-2
iSQL*Plus

add a server, 3-18, 3-19
configuring the extension, 3-17
defining server connect string, 3-18
defining server mode, load or execute, 3-18
defining server name, 3-18
defining server URL, 3-17
Extension for Windows, 3-16
Extension for Windows registry entries, A-4
extension, setting file association, 3-18
iSQL*Plus registry entry, A-4
modify a server definition, 3-20
remove a server, 3-18
remove a server definition, 3-20
Server registry entry, A-4
setting language in extension, 3-18

L
language, setting for iSQL*Plus extension, 3-18
load, iSQL*Plus extension, 3-18
LOCAL parameter, 4-5
Log On dialog, 3-4
login, automatic, 4-2
LOGIN.SQL file, 4-3
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M
menus, Windows GUI, 3-7
modify iSQL*Plus extension server definition, 3-20
mouse, using to copy command, 3-6
MS-DOS, accessing from SQL*Plus, 4-4
multiple Oracle homes, specifying font, 3-13

N
name, iSQL*Plus extension, 3-18
net_service_name

See connect_identifier

O
online help

accessing online help, 2-3
installation prerequisites, 2-2
installing, 2-2
obtaining for SQL*Plus, 1-3, 2-2

operating systems, supported by SQL*Plus, -vii
Options menu, 3-9
ORA error messages, 4-2
ORACLE home

explained, -xv
Oracle home

specifying font, 3-13
ORACLE_BASE

explained, -xv
overview, 1-2

P
parameter

SQLPATH, 4-3, A-2
SQLPLUS_FONT, 3-12, A-3
SQLPLUS_FONT_CHARSET, A-3
SQLPLUS_FONT_SIZE, 3-12, A-3

pasting text, 3-8
PLS error messages, 4-2
PL/SQL, relation to SQL*Plus, 1-2
prerequisites, installing online help, 2-2
PRODUCT_USER_PROFILE table, 4-4
PUPBLD.SQL file, 4-4

Q
query

defined, 1-3
results defined, 1-3

R
REGEDIT.EXE, A-2
REGEDT32.EXE, A-2
registry

editor, 3-12, A-2, A-3
iSQL*Plus entry, A-4
iSQL*Plus Extension for Windows entries, A-4
iSQL*Plus Server entry, A-4
REGEDIT.EXE, A-2
REGEDT32.EXE, A-2
SQLPATH entry, 4-3, A-2
SQLPLUS_FONT entry, 3-12, A-3
SQLPLUS_FONT_CHARSET entry, A-3
SQLPLUS_FONT_SIZE entry, 3-12, A-3

remove
iSQL*Plus extension server, 3-20
server from iSQL*Plus extension, 3-18

report, defined, 1-3
rules, for Windows arguments, 3-2
Run menu command, 3-8

S
sample tables, 2-4
saving, command files, 3-7
screen buffer area, 3-10
script

See command file
Search menu, 3-9
security

PRODUCT_USER_PROFILE table, 4-4
sending results to a file, 4-3
server

adding to iSQL*Plus, 3-18, 3-19
defining iSQL*Plus connect string, 3-18
defining iSQL*Plus mode, load or execute, 3-18
defining iSQL*Plus name, 3-18
defining iSQL*Plus url, 3-17
modifying an iSQL*Plus server definition, 3-20
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server (cont)
removing an iSQL*Plus server definition, 3-20
removing from iSQL*Plus extension, 3-18

SET
See alsoWindows GUI

setting system variables
SET NEWPAGE command, 4-4
Set Options area, 3-9
SET TIMING command, 4-2
setting up, using LOGIN and GLOGIN, 4-3
shortcuts to starting SQL*Plus, 4-2
SP2 error messages, 4-2
special characters

choosing a font, 3-4
Euro sign, 3-4, 3-13, 3-15
using, 3-4, 3-15

SPOOL command, 4-3
spool files, 4-3
spool menu command, 3-7
SPOOL OUT clause, not supported, 4-3
SQL buffer, 3-7
SQL*Plus

application window, 3-5
basic concepts, 1-3
command defined, 1-3
command-line interface, 3-2
exiting, 3-15
installing, 2-2
installing online help, 2-2
menus, 3-7
setting up environment, 4-3
setting up environment from GUI, 3-9
shortcuts to starting, 4-2
starting, 3-2
using LOGIN and GLOGIN to setup, 4-3
Windows versions supported, -vii

SQL*Plus Windows GUI
changing face and size, 3-12, 3-13
changing font, 3-12

SQLPATH registry entry, 4-3, A-2
SQLPLUS Environment Variable, A-4
SQLPLUS_FONT parameter, 3-12
SQLPLUS_FONT registry entry, A-3
SQLPLUS_FONT_CHARSET registry entry, A-3
SQLPLUS_FONT_SIZE parameter, 3-12

SQLPLUS_FONT_SIZE registry entry, A-3
START command, 4-3
Start menu, starting SQL*Plus, 3-4
starting

SQL*Plus, 3-2
SQL*Plus Windows GUI, 3-4

subkey, registry, A-2, A-3
system requirements, 2-2
system variables

screen buffer, 3-10
Set Options area, 3-9
setting, 3-9
value area, 3-9

T
tables

defined, 1-3
demonstration, 2-4

text editor
defining, 3-8
invoking, 3-8

TIMING command, 4-2
TNS error messages, 4-2

U
URL, iSQL*Plus extension, 3-17

V
value area, 3-9
value screen area, 3-9

W
Windows

extension for iSQL*Plus, 3-16
setting the file association, 3-18
versions supported, -vii, -viii

Windows GUI
application window, 3-5
cancelling, 3-8
changing face and size, 3-12, 3-13
changing font, 3-12
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Windows GUI (cont)
command keys, 3-6
exiting, 3-8
File menu, 3-7
Log On dialog, 3-4
menus, 3-7
setting system variables, 3-9
starting SQL*Plus, 3-4

Windows Operating Systems
versions supported, -viii
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